
CHÖÔNG II. 
SÔ BOÄ VEÀ MAPINFO

MapInfo laø moät phaàn meàm nhaèm giuùp chuùng ta xöû lyù baûn ñoà soá cuõng nhö caùc thoâng
tin lieân quan ñeán ñòa lyù. Tröôùc ñaây xöû lyù baûn ñoà laø moät chöùc naêng chuyeân nghieäp cuûa
ngaønh baûn ñoà hoïc. Vôùi söï ra ñôøi cuûa MapInfo, vieäc xöû lyù baûn ñoà trôû neân moät coâng vieäc
maø moïi ngöôøi ñeàu coù theå laøm ñöôïc. Khoâng nhöõng coù caùc chöùc naêng cuûa baûn ñoà thoâng
duïng nhö cung caáp thoâng tin ñòa lyù, giuùp ñònh vò trong thöïc ñòa,... MapInfo coøn laø moät
phaàn meàm raát maïnh giuùp xöû lyù vaø phaân tích thoâng tin treân baûn ñoà soá. Chöùc naêng naøy
cuûa MapInfo khieán cho noù trôû thaønh moät heä cô sôû döõ lieäu ñòa lyù. Tính naêng naøy coøn
ñöôïc taêng cöôøng theâm nhôø khaû naêng lieân keát ñöôïc vôùi caùc heä cô sôû döõ lieäu khaùc nhö
Microsoft Access, SQL Server, Oracle,... Söû duïng MapInfo coù theå hoã trôï giaûi quyeát
ñöôïc nhieàu vaán ñeà thöïc teá moät caùch nhanh choùng vaø chính xaùc.

II.1. SÔ BOÄ VEÀ BAÛN ÑOÀ TRONG MAPINFO

Moät baûn ñoà trong MapInfo bao goàm hai phaàn: phaàn baûn ñoà (hay phaàn ñoà hoïa) vaø
phaàn döõ lieäu (hay thoâng tin).

II.1.1. Ñoà hoaï

Phaàn ñoà hoaï cuûa MapInfo laø nhöõng vaät theå ñöôïc bieåu hieän treân maøn hình maùy tính
gioáng nhö baûn ñoà giaáy nhöng coù baûn chaát khaùc. Phaàn ñoà hoaï ñöôïc hieån thò trong cöûa
soå baûn ñoà (Map Window). MapInfo söû duïng caùc khaùi nieäm toaùn hoïc ñeå bieåu dieãn caùc
chi tieát treân baûn ñoà. Coù ba kieåu khaùi nieäm toaùn hoïc chính ñöôïc söû duïng ñeå xaây döïng
baûn ñoà treân MapInfo (hình I.1):

- Ñieåm: laø moät vaät theå toaùn hoïc khoâng coù kích thöôùc, khoâng coù chieàu daøi, chæ coù toaï
ñoä (trong moät heä truïc toaï ñoä naøo ñoù). Ngöôøi ta söû duïng vaät theå ñieåm ñeå minh hoïa
cho moät thaønh phoá, moät traïm xaêng, moät tröôøng hoïc,...Ñieåm ñöôïc töông tröng baèng
moät chaám trong toaùn hoïc. Trong MapInfo, tuyø theo noäi dung cuûa ñieåm ñoù (minh hoïa
cho caùi gì) maø ngöôøi ta coù theå söû duïng moät trong nhieàu bieåu töôïng khaùc nhau ñeå
minh hoaï cho moät ñieåm. Vì vaäy ñieåm trong MapInfo ñöôïc goïi laø bieåu töôïng (sym-
bol).

- Ñöôøng: laø moät vaät theå hình hoïc khoâng coù chieàu roäng nhöng coù chieàu daøi. Ñöôøng
trong MapInfo bao goàm caùc thaønh phaàn nhoû ñöôïc goïi laø ñoaïn (segment). Giöõa hai
ñoaïn lieàn nhau laø noát (node). Caùc ñieåm noát naøy cho pheùp ta chænh söûa caùc ñöôøng.
Ñöôøng ñöôïc söû duïng ñeå minh hoïa cho moät con soâng, moät ñöôøng giao thoâng,...

- Vuøng: laø moät vaät theå coù dieän tích. Vuøng cuõng bao goàm caùc thaønh phaàn nhoû laø ñoaïn
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vaø caùc ñieåm noát nhöng ñoaïn ñaàu tieân vaø ñoaïn cuoái cuøng gaëp nhau neân taïo ra moät
ñöôøng kheùp kín vaø phaàn phía trong ñöôøng ranh giôùi ñoù coù dieän tích. Vuøng coù chu vi
laø ñöôøng giôùi haïn ranh giôùi cuûa vuøng ñoù. Vuøng thöïc chaát laø moät hình ña giaùc. Vuøng
ñöôïc söû duïng ñeå minh hoaï cho moät quaän, moät tænh, moät caùi ao,...

Caùc thoâng tin ñoà hoaï treân MapInfo ñöôïc goïi laø caùc vaät theå (object).
Ngöôøi laøm baûn ñoà soá caàn phaûi bieát caùch vi tính hoaù (hay soá hoaù) nhöõng thoâng tin

ñòa lyù töø baûn ñoà giaáy vaøo baûn ñoà soá sao cho ñuùng caùch. Ví duï nhö khi noùi ñeán moät caùi
ao coù theå “nhìn” thaáy (töùc laø thaáy ñöôïc baèng maét thöôøng treân baûn ñoà giaáy hình daïng
cuûa caùi ao, ôû moät tyû leä naøo ñoù), thì ta soá hoaù noù thaønh moät vuøng, nhöng khi laøm moät
baûn ñoà coù tyû leä raát nhoû thì ta khoâng theå nhìn thaáy hình daïng caùi ao ñoù, thì caùi ao ñoù
neân ñöôïc minh hoïa thaønh moät ñieåm. Töông töï nhö vaäy, moät con ñöôøng treân moät baûn
ñoà tyû leä nhoû thì ñöôïc minh hoïa baèng kieåu ñöôøng nhöng ñoái vôùi baûn ñoà coù tyû leä raát lôùn
thì con ñöôøng ñoù seõ coù chieàu roäng, luùc ñoù ta laïi phaûi minh hoïa con ñöôøng ñoù baèng moät
vaät theå kieåu vuøng. Hoaëc ví duï nhö treân baûn ñoà nöôùc Vieät Nam, caùc thaønh phoá ñöôïc
bieåu thò baèng nhöõng caùi chaám, töùc laø ñieåm nhöng khi xem xeùt moät thaønh phoá ôû tyû leä
lôùn hôn nhieàu thì thaønh phoá ñoù laïi laø moät vuøng.

Phaàn ñoà hoaï trong MapInfo ñöôïc quaûn lyù theo lôùp (layer), coù nghóa laø caùc thoâng tin
ñòa lyù ñöôïc toå chöùc theo töøng nhoùm, ví duï nhö treân baûn ñoà moät thaønh phoá, ta coù lôùp
ñöôøng xaù, lôùp quaän, lôùp ñòa danh, lôùp soâng suoái,.. Nhôø khaû naêng naøy maø ta coù theå hieån
thò thoâng tin theo yù muoán. Khi muoán söû duïng nhöõng thoâng tin naøo ta coù theå môû nhöõng
lôùp thoâng tin ñoù ra. Cöûa soå baûn ñoà coù theå chöùa moät hay nhieàu lôùp baûn ñoà ñang ñöôïc
môû. Neáu caùc lôùp baûn ñoà thuoäc cuøng moät vò trí ñòa lyù thì coù theå hieån thò choàng leân nhau.
Ta coù theå hình dung moãi lôùp baûn ñoà nhö laø moät tôø giaáy kính (transparency) coù hình veõ
vaø baûn ñoà gioáng nhö nhieàu tôø giaáy kính choàng leân nhau ñeå taïo ra moät caùi nhìn cuoái
cuøng. Caùc lôùp baûn ñoà ñöôïc saép xeáp theo thöù töï treân döôùi, coù nghóa laø lôùp ôû döôùi bò lôùp

Hình I.1. Caùc kieåu vaät theå ñoà hoaï chính trong MapInfo
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ôû treân che khuaát nhöõng phaàn chung. Ngoaøi ra phía treân cuøng caùc lôùp baûn ñoà ñöôïc môû
luoân luoân coù moät lôùp maëc ñònh ñöôïc goïi laø lôùp Cosmetic (Cosmetic Layer). Lôùp naøy
gioáng nhö moät lôùp nhaùp, ta coù theå ñaùnh daáu chænh söûa vaøo lôùp naøy vaø theâm bôùt caùc
vaät theå ñoà hoaï vaøo noù nhöng khoâng aûnh höôûng ñeán caùc lôùp baûn ñoà khaùc ôû döôùi. Nhöõng
vaät theå ñöôïc veõ theâm vaøo lôùp baûn ñoà naøy coù theå ñöôïc löu vaøo nhöõng lôùp baûn ñoà ñang
ñöôïc môû hoaëc ñöôïc löu thaønh moät lôùp baûn ñoà rieâng. Lôùp Cosmetic coøn ñöôïc söû duïng
trong vieäc trình baøy baûn ñoà khi in aán, ví duï nhö theâm caùc chi tieát ñeå trình baøy baûn ñoà.
Caùc vaät theå trong lôùp naøy khoâng coù phaàn döõ lieäu.

II.1.2. Döõ lieäu

Ngoaøi phaàn vaät theå ñoà hoaï, baûn ñoà soá trong MapInfo coøn coù döõ lieäu ñöôïc hieån thò
trong moät cöûa soå ñöôïc goïi laø cöûa soå Browser (cöûa soå döõ lieäu). Döõ lieäu trong MapInfo
hieån thò treân moät baûng vaø chuùng ñöôïc caáu truùc theo kieåu döõ lieäu töông töï caùc kieåu döõ
lieäu khaùc nhö Excel, Access,... Ngoaøi ra MapInfo cuõng coù theå môû caùc döõ lieäu khaùc. Ta
coù theå môû moät taäp tin Excel hay Access trong MapInfo vaø xöû lyù chuùng nhö nhöõng baûng
döõ lieäu bình thöôøng cuûa MapInfo.

Moãi cöûa soå döõ lieäu coù theå hieån thò thoâng tin cuûa moät lôùp baûn ñoà hay moät phaàn cuûa
moät lôùp baûn ñoà. Cöûa soå naøy bao goàm caùc oâ gioáng nhö baûng tính Excel. Caùc oâ ñöôïc
xeáp theo chieàu doïc ñöôïc goïi laø tröôøng (field) hay coät (column). Moãi coät hieån thò moät loaïi
thuoäc tính cuûa vaät theå treân baûn ñoà soá, ví duï ñoái vôùi baûn ñoà caùc tænh cuûa Vieät Nam chaúng
haïn, ta coù theå coù caùc coät teân tænh, dieän tích tænh, chu vi tænh, daân soá,... Moãi moät coät coù
moät ñònh daïng khaùc nhau tuyø theo noäi dung chöùa trong coät ñoù. Ta coù theå theâm hay bôùt
tröôøng cuõng nhö thay ñoåi ñònh daïng caùc tröôøng. Teân tröôøng khoâng hieån thò tieáng Vieät
ñöôïc neân khi taïo tröôøng ta khoâng ñöôïc goõ daáu tieáng Vieät vaøo teân tröôøng. Treân cuøng
cöûa soå döõ lieäu coù tieâu ñeà coät (in ñaäm), töùc teân tröôøng. Caùc haøng trong cöûa soå döõ lieäu
ñöôïc goïi laø baûn ghi (record). Beân traùi moãi haøng coù moät oâ vuoâng. Khi söû duïng coâng cuï
choïn, ta coù theå nhaép chuoät leân oâ vuoâng ñoù ñeå choïn baûn ghi ñoù. Khi ñöôïc choïn, oâ vuoâng
bieán thaønh maøu ñen. Moãi moät baûn ghi lieân keát vôùi moät vaät theå ñoà hoaï treân cöûa soå baûn
ñoà, hay noùi caùch khaùc moãi vaät theå ñoà hoïa treân cöûa soå baûn ñoà coù thoâng tin naèm treân
moät haøng trong cöûa soå döõ lieäu. Vaät theå ñoà hoaï vaø döõ lieäu laø hai thaønh phaàn thoáng nhaát
cuûa moät baûn ñoà soá trong MapInfo. Neáu môû cöûa soå ñoà hoaï vaø cöûa soå döõ lieäu cuûa moät
lôùp baûn ñoà cuøng moät luùc thì khi söû duïng coâng cuï choïn, ta coù theå nhaép chuoät leân choïn
moät vaät theå ñoà hoaï treân cöûa soå baûn ñoà. Khi moät vaät theå treân cöûa soå baûn ñoà ñöôïc choïn
thì baûn ghi töông öùng trong cöûa soå döõ lieäu cuõng ñöôïc choïn vaø ngöôïc laïi.

Neáu ta quan nieäm baûn ñoà soá nhö laø caùc lôùp vaät theå ñoà hoaï thì cöûa soå döõ lieäu laø
thoâng tin cuûa vaät theå treân baûn ñoà. Neáu ta quan nieäm baûn ñoà soá nhö laø moät cô sôû döõ
lieäu thì caùc vaät theå ñoà hoaï treân moät lôùp baûn ñoà laø moät “coät”, ñöôïc goïi laø “coät vaät theå”
(object column hay obj column), vì coät ñoù khoâng hieån thò ñöôïc trong cöûa soå döõ lieäu neân
ñöôïc hieån thò rieâng trong cöûa soå baûn ñoà. Vì MapInfo quan nieäm baûn ñoà soá nhö moät cô
sôû döõ lieäu vôùi caùc vaät theå trong cöûa soå baûn ñoà ñöôïc coi laø moät “coät” neân moät baûn ñoà
cuõng ñöôïc goïi laø moät baûng (table). MapInfo söû duïng thuaät ngöõ naøy ñeå chæ caû döõ lieäu
laãn ñoà hoaï (“coät” vaät theå) trong moät baûn ñoà soá. Moät baûng cuûa MapInfo coù theå khoâng coù
“coät” vaät theå. Luùc ñoù chuùng hoaøn toaøn gioáng nhö moät cô sôû döõ lieäu bình thöôøng, kieåu
döõ lieäu cuûa Excel hay Access. Cöûa soå döõ lieäu coù theå laø döõ lieäu nguyeân thuyû cuûa
MapInfo (native) hay döõ lieäu cuûa coù caùc ñònh daïng khaùc (nhö Excel, Access,..) nhöng
ñöôïc ñaêng kyù vaøo MapInfo.

Nhöõng tính chaát lieân quan ñeán ñoà hoaï cuûa baûn ñoà soá ñöôïc xöû lyù trong cöûa soå baûn
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ñoà. Nhöõng thoâng tin lieân quan ñeán döõ lieäu (teân, daân soá, thuoäc tính, ñaëc ñieåm,...) ñöôïc
xöû lyù trong caùc tröôøng cuûa cöûa soå döõ lieäu. Nhöõng thoâng tin veà döõ lieäu naøy coù theå ñöôïc
ñöa leân baûn ñoà baèng moät soá leänh khaùc nhau ñeå minh hoaï laøm roõ baûn ñoà luùc trình baøy
baûn ñoà ñeå in hoaëc tieán haønh phaân tích nhö moät heä cô sôû döõ lieäu bình thöôøng vaø keát
quaû phaân tích cuõng coù theå ñöôïc phaûn aùnh treân cöûa soå baûn ñoà. Ngöôïc laïi, moät soá thoâng
tin treân baûn ñoà coù theå ñöôïc caäp nhaät vaøo döõ lieäu baèng moät soá leänh. Tuyø nhu caàu ngöôøi
duøng coù theå môû cöûa soå baûn ñoà hay cöûa soå döõ lieäu hay caû hai. Ngoaøi ra coøn coù moät soá
loaïi cöûa soå khaùc trong MapInfo maø ta seõ xem xeùt trong caùc chöông sau.

Töø phaàn naøy trôû ñi, ta seõ duøng töø baûng ñeå chæ moät baûng cuûa MapInfo (coù theå bao
goàm caû phaàn döõ lieäu laãn phaàn ñoà hoaï hay chæ coù phaàn döõ lieäu), lôùp (hay lôùp baûn ñoà)
ñeå ñeà caäp ñeán phaàn ñoà hoïa cuûa baûng MapInfo trong cöûa soå baûn ñoà (“coät” vaät theå),
baûng döõ lieäu ñeå chæ ñeà caäp ñeán phaàn döõ lieäu cuûa moät baûng MapInfo.

II.2. GIAO DIEÄN CUÛA MAPINFO

Khi khôûi ñoäng MapInfo, treân maøn hình coù caùc thaønh phaàn chính sau:

- Menu chính: goàm caùc menu leänh chính cuûa MapInfo laø File, Edit, Tools, Object,
Query, Table, Options, Map/Browse (hay moät menu khaùc, tuyø vaøo cöûa soå naøo
ñang ñöôïc kích hoaït), Window, Help.

- Thanh coâng cuï: Coù 3 thanh coâng cuï chính laø Standard, Main, Drawing.

Thanh coâng cuï Standard goàm caùc leänh thöôøng ñöôïc söû duïng trong caùc menu
chính.

Thanh coâng cuï Main goàm 23 nuùt leänh lieân quan ñeán caùc thaønh phaàn chính cuûa moät
baûn ñoà soá nhö leänh choïn, chænh thieát laäp cöûa soå baûn ñoà, bieåu ñoà/ñoà thò, kieåm soaùt lôùp,...

Thanh coâng cuï Drawing bao goàm caùc nuùt leänh lieân quan ñeán vieäc veõ vaø chænh söûa
phaàn ñoà hoaï cuûa baûn ñoà.

Ngoaøi ra neáu coù caøi ñaët DBMS (MapInfo phieân baûn 6 trôû leân) hay ODBC (MapInfo
phieân baûn 5) thì coøn moät thanh coâng cuï nöõa laø DBMS (hay ODBC). Ñaây laø thanh coâng
cuï cho pheùp lieân keát vaø thao taùc vôùi döõ lieäu cuûa caùc heä döõ lieäu khaùc nhö Access, SQL
Server,...

Döôùi cuøng cöûa soå MapInfo laø thanh Traïng thaùi (Status Bar). Thanh naøy cho bieát
thoâng tin cuõng nhö tình traïng cuûa cöûa soå ñang ñöôïc kích hoaït.

Ta haõy môû moät baûng coù baûn ñoà ra laø baûn ñoà caùc tænh cuûa Vieät Nam. Baûng naøy coù
teân laø cac_tinh. Caùch môû nhö sau: 

- Khôûi ñoäng MapInfo, cöûa soå Quick Start hieän ra

- Choïn Open a Table > Open, vaøo thö muïc coù chöùa taäp tin cac_tinh.tab vaø choïn noù
roài choïn Open.

Ta seõ thaáy cöûa soå baûn ñoà ñöôïc môû ra. Ñeå thaáy cöûa soå döõ lieäu, ta choïn Window >
New Browser Window, cöûa soå döõ lieäu cuûa baûn ñoà cac_tinh ñöôïc môû ra (hình I.2).

Ta coù theå môû nhieàu cöûa soå khaùc nhau cuøng moät luùc trong MapInfo. Tuy nhieân vaøo
moät thôøi ñieåm chæ coù moät cöûa soå ñöôïc kích hoaït. Cöûa soå ñöôïc kích hoaït laø cöûa soå coù
maøu xanh treân thanh tieâu ñeà (maøu maëc ñònh, maøu naøy coù theå khaùc tuyø thieát laäp maøu
treân heä ñieàu haønh), nhöõng cöûa soå khoâng ñöôïc kích hoaït coù maøu xaùm. Ta kích hoaït moät
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Hình I.2. Maøn hình MapInfo ôû cheá ñoä thöôøng söû duïng nhaát

Thanh coâng cuï Standard

Thanh coâng cuï Main

Thanh coâng cuï Drawing

Menu chính

Cöûa soå Döõ lieäu

Cöûa soå Baûn ñoà

Cöûa soå chính cuûa MapInfo

Thanh Traïng thaùi
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cöûa soå baûn ñoà baèng caùch nhaép chuoät vaøo thanh tieâu ñeà cuûa cöûa soå ñoù hoaëc töø menu
chính choïn Window > <teân cöûa soå>. Nhöõng thao taùc ta thöïc hieän chæ taùc ñoäng leân cöûa
soå naøo ñang ñöôïc kích hoaït. Cöûa soå ñöôïc kích hoaït luoân luoân naèm treân cuøng.

ÔÛ goùc treân beân phaûi cuûa moãi cöûa soå cuõng coù 3 nuùt gioáng nhö 3 nuùt cuûa baát kyø cöûa
soå naøo trong heä ñieàu haønh Window, ñoù laø thu nhoû , phoùng to vaø taét cöûa soå .
Löu yù laø nuùt taét cöûa soå trong MapInfo chæ taét cöûa soå ñoù ñi chöù caùc taäp tin baûn ñoà hay
döõ lieäu treân cöûa soå ñoù thì khoâng. Muoán ñoùng hoaøn toaøn moät baûng cuûa MapInfo thì ta
phaûi duøng leänh File > Close Table.

II.2.1. Menu chính cuûa MapInfo

Tröôùc khi tìm hieåu veà caùch söû duïng MapInfo, chuùng ta caàn xem xeùt sô qua yù nghóa
menu chính vaø caùc thanh coâng cuï cuûa MapInfo.

II.2.1.1. Menu File

Bao goàm caùc leänh sau (hình II.3):

- New Table: Laø leänh taïo moät baûng môùi, töông ñöông nuùt leänh New Table treân

thanh coâng cuï Standard. Khi choïn leänh naøy MapInfo seõ hieån thò caùc hoäp thoaïi qua

nhieàu böôùc ñeå giuùp ta taïo moät baûng môùi. Nhöõng leänh naøy chuû yeáu lieân quan ñeán

vieäc taïo caùc tröôøng vaø xaùc ñònh heä quy chieáu (neáu coù phaàn baûn ñoà) cho moät baûng
môùi. Baûng ñöôïc taïo ra môùi nhö vaäy khoâng coù vaät theå treân baûn ñoà vaø vaø chöa coù

thoâng tin trong döõ lieäu. Xem chi tieát caùch taïo baûng môùi trong phaàn ///.

- Open Table: Môû moät baûng MapInfo, töông ñöông nuùt leänh Open Table treân
thanh coâng cuï Standard.

- Open DBMS Table: Môû moät baûng lieân quan ñeán moät cô sôû döõ lieäu naèm ngoaøi

MapInfo, töông ñöông nuùt leänh Open DBMS Table treân thanh coâng cuï DBMS.

Ñaây laø phaàn tuyø choïn khi caøi ñaët MapInfo. Leänh naøy chæ coù khi ta caøi ñaët DBMS.
Xem trong phaàn ///.

- Open Workspace: Môû moät taäp tin workspace (khoâng gian laøm vieäc) cuûa MapInfo. Xin
xem tieáp phaàn döôùi. 

- Close Table: Ñoùng moät baûng. Khi ñang môû nhieàu baûng moät luùc, seõ coù moät hoäp thoaïi
hieän ra hoûi ñoùng baûng naøo. Neáu baûng caàn ñoùng coù chænh söûa thì MapInfo hieän ra
moät hoäp thoaïi nöõa hoûi coù muoán löu nhöõng chænh söûa khoâng, xem tieáp phaàn döôùi.

- Close all: Ñoùng taát caû caùc baûng ñang môû. Neáu coù moät baûng naøo ñöôïc chænh söûa
nhöng chöa ñöôïc löu MapInfo seõ hieån thò hoäp thoaïi Save Modified Table Data vaø
lieät keâ laàn löôït nhöõng baûng chöa ñöôïc löu. Ta coù theå löu baûng baèng caùch choïn nuùt
Save. Neáu khoâng muoán löu nhöõng thay ñoåi treân moät baûng naøo ñoù thì ta nhaán nuùt
Discard. Neáu khoâng muoán löu taát caû nhöõng baûng ñaõ coù chænh söûa hay thay ñoåi thì
ta choïn Discard All.

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com


- Close DBMS Connection: ñoùng
moät lieân keát DBMS (cô sôû döõ
lieäu beân ngoaøi). Neáu moät baûng
cuûa cô sôû döõ lieäu ngoaøi
MapInfo ñang ñöôïc môû thì ta
khoâng theå duøng leänh naøy.

- Save Table: Löu nhöõng thay
ñoåi treân baûng, töông ñöông
nuùt leänh Save Table treân
thanh coâng cuï Standard. Khi
choïn leänh naøy, MapInfo hieän
ra moät hoäp thoaïi lieät keâ danh
saùch nhöõng baûng coù thay ñoåi
nhöng chöa ñöôïc löu, ta choïn
baûng naøo muoán löu vaø nhaán
nuùt Save.

- Save Copy As: Löu moät baûng
thaønh moät baûng khaùc.

- Save Query: Löu moät Query
(keát quaû cuûa moät pheùp truy
vaán, tìm kieám hay moät pheùp
choïn naøo ñoù) thaønh moät baûng
rieâng.

- Save workspace: Löu work-
space. Noùi moät caùch noâm na
thì workspace laø nhöõng gì ta
ñang laøm treân MapInfo. Ví duï
nhö khi ñang trình baøy baûn ñoà maø dôû dang chöa xong, ta coù theå duøng leänh löu work-
space ñeå löu laïi tình traïng dôû dang ñoù roài ñoùng MapInfo, taét maùy tính hoaëc laøm coâng
vieäc khaùc. Khi khôûi ñoäng laïi MapInfo vaø môû workspace ñoù ra, taát caû nhöõng gì ta
ñang laøm dôû dang seõ ñöôïc phuïc hoài laïi nguyeân traïng vaø ta coù theå tieáp tuïc coâng vieäc
maø khoâng phaûi baét ñaàu laïi töø ñaàu. Workspace ñöôïc söû duïng chuû yeáu trong vieäc trình
baøy baûn ñoà cuõng nhö khi phaân tích döõ lieäu. Ta coù theå löu bao nhieâu workspace cuõng
ñöôïc. Workspace khoâng laøm thay ñoåi noäi dung baûng cuûa MapInfo.

- Save Window as: Löu cöûa soå ñang ñöôïc kích hoaït thaønh moät taäp tin hình aûnh.

- Revert Table: Huyû boû nhöõng thay ñoåi ñaõ ñöôïc thöïc hieän nhöng chöa ra leänh löu.

- Run MapBasic Program: chaïy moät chöông trình MapBasic, töông ñöông vôùi nuùt leänh
Run MapBasic Program Button neáu ta môû thanh coâng cuï Tools ra. MapBasic
laø moät phaàn meàm cho pheùp ta taïo theâm chöùc naêng cho MapInfo ngoaøi nhöõng chöùc
naêng ñaõ coù saün cuûa chöông trình chính. Khi caøi ñaët MapInfo, moät soá chöông trình
MapBasic ñöôïc tích hôïp saün vaøo MapInfo. Nhöõng chöông trình naøy naèm trong thö
muïc MapInfo\Professional\Tools. Xem theâm trong phaàn Phuï Luïc.

Hình II.3. Menu File
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- Page Set Up: Ñònh daïng trang in.

- Print: In moät cöûa soå cuûa MapInfo, töông ñöông nuùt leänh Print Window Button
treân thanh coâng cuï Standard.

- Exit: Thoaùt khoûi MapInfo, töông ñöông vôùi toå hôïp phím <Alt>+<F4>.

II.2.1.2. Menu Edit
Menu naøy cho pheùp thöïc hieän caùc leänh lieân quan ñeán vieäc chænh söûa caùc vaät theå

hay döõ lieäu cuõng nhö xem thoâng tin (hình I.4).

- Undo: huyû boû moät leänh vöøa ñöôïc thöïc hieän, töông ñöông vôùi nuùt leänh Undo Button

treân thanh coâng cuï Standard. Leänh Undo naøy chæ hieän ra khi ta vöøa thöïc hieän

moät thay ñoåi naøo ñoù treân baûn ñoà. Leänh naøy hieän chung vôùi teân leänh vöøa ñöôïc thöïc

hieän giuùp ta nhôù laïi mình vöøa laøm gì. Ví duï neáu ta veõ theâm (Add) moät vaät theå vaøo

baûn ñoà thì leänh hieän ra seõ laø Undo Add. Khi ñaõ choïn leänh naøy thì leänh Undo seõ

chuyeån thaønh Redo (laøm laïi).

- Cut: xoaù moät/nhieàu baûn ghi hay moät/nhieàu vaät theå ñoà hoaï ñang ñöôïc choïn, töông

ñöông vôùi nuùt leänh Cut Button treân thanh

coâng cuï Standard. Ñoái vôùi döõ lieäu, leänh naøy

xoaù ñi (caùc) haøng ñöôïc choïn. Ñoái vôùi phaàn

baûn ñoà cuûa MapInfo, ta coù theå xoaù moät hay

nhieàu vaät theå ñoà hoaï treân baûn ñoà sau khi choïn

chuùng. Löu yù raèng ñoái vôùi caùc vaät theå ñoà hoïa

treân baûn ñoà, leänh naøy chæ coù taùc duïng khi lôùp

baûn ñoà coù chöùa vaät theå ñang ñöôïc choïn ôû cheá

ñoä chænh söûa. Xem theâm trong Chöông X,

Kieåm soaùt Lôùp. Phaàn bò caét seõ ñöôïc xoaù vaø

ñöa vaøo boä nhôù taïm (clipboard) chöù chöa bò xoaù hoaøn toaøn. Khi xoaù moät vaät theå ñoà

hoaï treân baûn ñoà thì haøng töông öùng treân baûng döõ lieäu cuõng bò xoaù vaø ngöôïc laïi.

Haøng bò xoaù ñoåi thaønh maøu xaùm vaø khoâng coøn döõ lieäu.

- Copy hay Copy Map Window: moät trong hai leänh naøy hieån thò tuyø theo cöûa soå naøo

ñang ñöôïc môû hay ñang ñöôïc kích hoaït (neáu coù nhieàu cöûa soå ñang môû), töông

ñöông vôùi nuùt leänh Copy Button treân thanh coâng cuï Standard. Neáu cöûa soå döõ

lieäu cuûa moät lôùp baûn ñoà ñang ñöôïc môû thì leänh Copy hieän leân. Neáu cöûa soå baûn ñoà

ñang ñöôïc kích hoaït thì leänh Copy Map Window hieän leân. Phoái hôïp hai leänh Copy

Hình 1.4. Menu Edit 
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Map Window vaø Paste seõ cho keát quaû töông töï leänh Clone View treân menu Map.

Xem tieáp trong phaàn Menu Map.

- Paste: daùn. Leänh naøy cho pheùp daùn (hay chuyeån) nhöõng gì ñaõ ñöôïc caét (trong leänh

Cut) hay sao (trong leänh Copy) leân baûng döõ lieäu hay leân baûn ñoà, töông ñöông vôùi

nuùt leänh Paste Button treân thanh coâng cuï Standard.

- Clear: xoaù vaät theå ñoà hoaï hay baûn ghi ñang ñöôïc choïn. Leänh naøy khoâng ñöa thoâng
tin bò xoaù vaøo boä nhôù taïm (maát haún).

- Clear Map Object Only: ñoái vôùi moät baûng vöøa coù vaät theå ñoà hoaï (baûn ñoà) vöøa coù döõ
lieäu, ta coù theå choïn leänh naøy ñeå chæ xoaù caùc vaät theå ñoà hoïa maø giöõ laïi nguyeân döõ
lieäu. Luùc naøy “baûng” cuûa MapInfo laø moät baûng thöïc söï (chæ coøn döõ lieäu chöù khoâng
coøn “baûn ñoà” nöõa).

- Reshape: chænh söûa hình daïng vaät theå. Ñaây laø leänh duøng ñeå chænh söûa hình daïng

caùc vaät theå ñoà hoaï baèng caùch chænh söûa caùc noát cuûa chuùng. Leänh naøy chæ coù yù nghóa

treân caùc vaät theå kieåu ñöôøng vaø vuøng. Ñoái vôùi vaät theå kieåu ñieåm, noù khoâng coù taùc

duïng. Leänh naøy chæ hieän roõ khi naøo vaät theå ñöôïc choïn naèm trong moät lôùp ñang ôû

cheá ñoä chænh söûa. Khi choïn vaät theå ñoù roài choïn nuùt naøy, caùc noát cuûa vaät theå ñoù hieän

leân, ta coù theå duøng nuùt leänh choïn ñeå di chuyeån caùc noát cuõng nhö theâm/bôùt caùc noát
ñeå thay ñoåi hình daïng cuûa vaät theå. Leänh naøy töông ñöông vôùi nuùt leänh Reshape
Button treân thanh coâng cuï Drawing.

- New Row: theâm moät haøng môùi vaøo baûng döõ lieäu cuûa MapInfo. Leänh naøy chæ hieän roõ
khi naøo cöûa soå döõ lieäu ñöôïc kích hoaït. Haøng môùi seõ ñöôïc cheøn vaøo cuoái baûng döõ
lieäu. Neáu ta choïn haøng ñoù vaø baét ñaàu veõ moät vaät theå ñoà hoaï môùi trong lôùp baûn ñoà
ñoù thì vaät theå môùi töï ñoäng lieân keát vôùi haøng ñoù.

- Get Info: xem thoâng tin trong baûng döõ lieäu cuûa vaät theå ñöôïc choïn. Leänh naøy ñöôïc
söû duïng baèng caùch choïn noù roài nhaép chuoät leân vaät theå ñoà hoaï treân cöûa soå baûn ñoà,
caùc thoâng tin trong baûng döõ lieäu cuûa vaät theå ñoù seõ ñöôïc hieån thò trong hoäp thoaïi Info
Tool. Leänh naøy töông ñöông vôùi nuùt leänh Info Button treân thanh coâng cuï Main.

II.2.1.3. Menu Tools
Menu Tools cho pheùp thieát laäp cheá ñoä khôûi ñoäng vaø chaïy caùc öùng duïng cuûa

MapBasic, caùc leänh chuyeån ñoåi ñònh daïng baûn ñoà soá cuõng nhö moät soá leänh lieân quan
ñeán caùc thoâng tin treân internet hay caùc ñòa chæ web (hình I.5).

- Crystal Reports: cho pheùp môû hay taïo moät Baùo caùo Crystal veà thoâng tin trong moät
baûng MapInfo.

- Tool Manager: quaûn lyù caùc chöông trình MapBasic. Leänh naøy cho pheùp ñieàu chænh
cheá ñoä khôûi ñoäng cuûa nhöõng chöông trình MapBasic vaø coù theå ñaêng kyù theâm öùng
duïng MapBasic (ví duï nhö moät chöông trình MapBasic do ta töï vieát chaúng haïn).
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- Arclink: laø phaàn lieân quan ñeán vieäc chuyeån ñoåi giöõa
caùc baûn ñoà soá cuûa ArcInfo vaø MapInfo.

- MetaData Browser Launcher: khôûi ñoäng moät lieân
keát vaøo internet vaø giuùp tìm kieám caùc baûn ñoà soá coù
treân maïng. Ñoái vôùi nöôùc ta, leänh naøy khoâng coù yù
nghóa gì nhieàu vì caùc baûn ñoà soá cuûa nöôùc ta chöa
ñöôïc thöông maïi hoaù roäng raõi treân maïng.

- Universal Translator: laø trình öùng duïng cho pheùp
dòch caùc baûn ñoà soá töø caùc phaàn meàm laøm baûn ñoà
soá khaùc sang MapInfo hay ngöôïc laïi. Trình öùng duïng naøy hoã trôï dòch moät soá  kieåu
baûn ñoà soá khaùc phoå bieán nhö ñònh daïng AutoCAD , ESRI Shape (Arcview),
Integraph/Microstation Design.

Löu yù raèng tuyø theo bao nhieâu trình MapBasic ñang ñöôïc khôûi ñoäng maø menu naøy
coù theå thay ñoåi. Ví duï neáu ta khôûi ñoäng trình veõ thöôùc tyû leä thì treân cöûa soå menu naøy
seõ coù theâm moät haøng nöõa cuûa öùng duïng naøy.

II.2.1.4. Menu Objects
Menu Objects goàm caùc leänh chænh söûa vaät theå ñoà

hoïa treân cöûa soå baûn ñoà. Caùc leänh trong menu naøy
khoâng coù taùc duïng leân kyù töï, ví duï nhö khi moät cöûa soå
döõ lieäu ñöôïc kích hoaït chaúng haïn thì caùc leänh trong
menu naøy bò môø ñi (hình I.6).

- Set Target: thieát laäp “muïc tieâu”. Moät hay nhieàu vaät
theå coù theå ñöôïc bieán thaønh “muïc tieâu” vaø caùc leänh
ñi sau seõ taùc duïng leân (caùc) vaät theå ñang laø muïc
tieâu ñoù. Vaät theå kieåu ñieåm vaø kieåu kyù töï khoâng theå
ñöôïc thieát laäp laøm muïc tieâu. Muoán thieát laäp
moät/nhieàu vaät theå laøm muïc tieâu, tröôùc heát ta phaûi
duøng coâng cuï choïn treân thanh coâng cuï Main ñeå
choïn moät/nhieàu vaät theå ñoù sau ñoù môùi choïn
Objects > Set Target. (Caùc) vaät theå chæ coù theå ñöôïc
thieát laäp laø muïc tieâu khi lôùp baûn ñoà chöùa (caùc) vaät
theå ñoù ôû cheá ñoä chænh söûa. Vaät theå ñang ñöôïc thieát
laäp laø muïc tieâu seõ ñöôïc ñaùnh daáu ñeå phaân bieät
ñöôïc vôùi nhöõng vaät theå khaùc treân cöûa soå baûn ñoà.

- Clear Target: huyû thieát laäp muïc tieâu. Khi caùc vaät
theå ñang ñöôïc thieát laäp laø muïc tieâu, choïn leänh naøy
seõ traû caùc vaät theå ñoù veà tình traïng bình thöôøng.

- Combine: nhaäp vaät theå. Ta coù theå duøng coâng cuï choïn ñeå choïn hai hay nhieàu vaät theå
vaø duøng leänh naøy ñeå nhaäp chuùng thaønh moät vaät theå. Khi goäp vaät theå ñoà hoïa treân
baûn ñoà, ta coù moät soá tuyø choïn ñeå goäp döõ lieäu cuûa caùc vaät theå ñoù. Xem chi tieát trong
Chöông V, muïc V.2.1 vaø Chöông XVII, muïc XVII.3.3.1.

- Split: Caét moät hay nhieàu vaät theå. Muoán caét moät hay nhieàu vaät theå thì (caùc) vaät theå
ñoù phaûi ñöôïc thieát laäp laø “muïc tieâu” tröôùc. Tieáp theo ta phaûi choïn moät/nhieàu vaät theå
caét roài sau ñoù môùi thöïc hieän leänh naøy.

Hình I.6. Menu Objects

Hình I.5. Menu Tools
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- Erase: Xoaù moät phaàn (hay toaøn boä) moät hay nhieàu vaät theå. Phaàn bò xoaù laø phaàn giao
(phaàn chung) vôùi moät hay nhieàu vaät theå caét. (Caùc) vaät theå bò xoùa phaûi ñöôïc thieát laäp
laø “muïc tieâu” tröôùc ñoù. Caùch thöïc hieän töông töï leänh Split.

- Erase Outside: xoaù phaàn khoâng chung (naèm ngoaøi) cuûa moät hay nhieàu vaät theå. Phaàn
bò xoaù laø phuû ñònh cuûa phaàn giao (phaàn khoâng chung) vôùi (caùc) vaät theå caét. (Caùc)
vaät theå chòu taùc ñoäng cuûa leänh naøy phaûi ñöôïc thieát laäp laø “muïc tieâu”. Caùch thöïc hieän
töông töï leänh Split.

- Overlay nodes: taïo ñieåm chung (noát) giöõa moät hay nhieàu vaät theå ñöôïc thieát laäp laø
“muïc tieâu” vôùi moät hay nhieàu vaät theå ñang ñöôïc choïn. Noát ñöôïc taïo thaønh treân (caùc)
vaät theå ñöôïc thieát laäp laø muïc tieâu.

Caùc leänh ôû treân khoâng coù taùc duïng leân vaät theå kieåu ñieåm vaø vaät theå caét (cutter) phaûi
laø vaät theå kieåu vuøng.

- Buffer: taïo vuøng ñeäm cho moät hay nhieàu vaät theå ñang ñöôïc choïn. Leänh naøy taïo ra
moät hay nhieàu vaät theå kieåu vuøng bao xung quanh (caùc) vaät theå ñöôïc choïn vôùi baùn
kính vuøng ñeäm do ta xaùc ñònh. Ví duï ta choïn moät ñieåm töôïng tröng cho moät thaønh
phoá vaø chaïy leänh taïo vuøng ñeäm vôùi baùn kính laø 5 km thì MapInfo seõ veõ moät voøng
troøn xung quanh thaønh phoá ñoù vôùi baùn kính laø 5 km.

- Convex Hull: leänh naøy taïo ra moät ña giaùc loài chaïy quanh caùc noát ngoaøi cuøng cuûa
nhöõng vaät theå ñöôïc choïn. Leänh naøy coù theå ñöôïc hình dung nhö laø caêng moät daây
cao su chaïy bao xung quanh caùc coïc. Vì laø ña giaùc loài neân vuøng taïo thaønh seõ khoâng
coù goùc trong naøo lôùn hôn 180 ñoä. Leänh naøy chæ coù taùc duïng khi naøo (caùc) vaät theå
ñoà hoïa ñöôïc choïn chöùa ít nhaát 3 noát khoâng thaúng haøng.

- Enclose: taïo ra (caùc) vuøng töø caùc ñöôøng caét nhau kheùp kín.

- Check Regions: Trong quaù trình soá hoaù caùc thoâng tin kieåu vuøng, ta coù theå soá hoaù loãi
(caùc vuøng khoâng khít nhau, daãn ñeán vieäc tính toaùn sai sau naøy). Leänh naøy giuùp kieåm
tra loãi sau khi soá hoaù caùc vaät theå vuøng.

- Smooth: laø leänh “bo troøn” goùc cuûa caùc vaät theå kieåu ñöôøng. Leänh naøy naén troøn caùc
ñoaïn cuûa ñöôøng thaønh caùc cung (arc) tieáp tuyeán vôùi goùc nhoû giöõa hai ñoaïn cuûa
ñöôøng. Ñaây chæ laø leänh giuùp hieån thò vaät theå kieåu ñöôøng sao cho chuùng troâng “troøn
tròa” hôn maø thoâi. Caùc pheùp tính toaùn (veà ñòa lyù) vaãn caên cöù treân vaät theå goác.

- Unsmooth: khöû taùc duïng “bo troøn” cuûa leänh Smooth.

- Convert to Region: laø leänh ñoåi vaät theå kieåu ñöôøng thaønh vaät theå kieåu vuøng.

- Convert to Polyline: laø leänh ngöôïc laïi, ñoåi vaät
theå kieåu vuøng thaønh vaät theå kieåu ñöôøng.

Ta seõ xem xeùt chi tieát nhöõng öùng duïng cuûa
caùc leänh naøy trong vieäc soá hoaù baûn ñoà vaø chænh
söûa vaät theå trong Chöông V.

II.2.1.5. Menu Query

Menu naøy bao goàm caùc leänh lieân quan ñeán
vieäc truy vaán, choïn, tìm thoâng tin trong caùc
baûng MapInfo (hình I.7). Hình I.7. Menu Query

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com


- Select: choïn vaät theå/döõ lieäu trong moät baûng. Khi duøng leänh naøy ta phaûi ñöa ra ñieàu
kieän ñeå MapInfo thöïc hieän pheùp choïn. Neáu cöûa soå baûn ñoà vaø cöûa soå Browser cuûa
moät lôùp cuøng môû thì caû döõ lieäu laãn vaät theå ñoà hoaï thoaû ñieàu kieän ñeàu ñöôïc choïn.

- SQL Select: cuõng laø moät leänh choïn nhöng SQL Select coù caáu truùc leänh phöùc taïp hôn
ñoàng thôøi noù cho pheùp ta choïn döõ lieäu maïnh hôn so vôùi leänh Select. Veà nguyeân taéc
thì leänh naøy cuõng töông töï nhö SQL cuûa caùc heä cô sôû döõ lieäu khaùc. SQL laø chöõ vieát
taét cuûa Structrured Query Language (Ngoân ngöõ Truy vaán coù Caáu truùc).

- Select All: choïn taát caû moät baûng (hay lôùp) naøo ñoù ñang ñöôïc môû. Thoâng thöôøng khi
môû nhieàu lôùp baûn ñoà khaùc nhau thì lôùp naøo naèm treân seõ ñöôïc choïn. Maëc ñònh thì
coù moät lôùp hieän ra sau leänh naøy cho pheùp ta choïn nhanh maø khoâng phaûi vaøo hoäp
thoaïi Select All.

- Unselect All: Khöû choïn nhöõng vaät theå hay baûn ghi ñang ñöôïc choïn.

- Find: tìm kieám. Leänh naøy cho pheùp ta tìm kieám moät vaät theå naøo ñoù treân baûn ñoà vaø
ñaùnh daáu noù laïi. Ta chæ coù theå söû duïng leänh naøy neáu baûng ñöôïc ñaùnh daáu laø
Indexed. Xem theâm trong Chöông XVII.

- Find Selection: di chuyeån noäi dung trong cöûa soå baûn ñoà hay cöûa soå döõ lieäu ñeå hieån
thò moät/nhieàu vaät theå/baûn ghi ñang ñöôïc choïn. Ví duï ta coù theå choïn moät hay nhieàu
baûn ghi treân cöûa soå döõ lieäu cuûa moät baûng nhöng khoâng thaáy chuùng treân baûn ñoà vì
baûn ñoà coù ñoä phoùng ñaïi quaù lôùn, duøng leänh naøy seõ giuùp thay ñoåi cöûa soå baûn ñoà ñeå
hieån thò (caùc) vaät theå ta ñang choïn trong cöûa soå döõ lieäu. Ngöôïc laïi neáu ta choïn moät
vaät theå treân cöûa soå baûn ñoà nhö khoâng thaáy baûn ghi ñoù ñöôïc choïn trong baûng döõ
lieäu, ta cuõng coù theå duøng leänh naøy ñeå cöûa soå Browser chuyeån ñeán haøng coù vaät theå
ta ñang choïn.

- Calculate Statistics: leänh naøy thöïc hieän moät soá tính toaùn thoáng keâ treân döõ lieäu cuûa
moät tröôøng trong moät baûng hay cuûa caùc vaät theå ñöôïc choïn trong moät baûng naøo ñoù.
Calculate Statistics chæ coù taùc duïng khi naøo baûng ñöôïc choïn chöùa caùc tröôøng kieåu
soá. Chi tieát leänh naøy ñöôïc trình baøy trong Chöông XVII, muïc XVII.3.2.

II.2.1.6. Menu Table

Menu naøy bao goàm caùc leänh lieân quan ñeán
caùc döõ lieäu cuûa caùc lôùp baûn ñoà cuûa MapInfo ñoàng
thôøi coù caùc leänh lieân quan ñeán caùc döõ lieäu ngoaøi
MapInfo. Menu naøy cuõng coù moät soá leänh chænh
söûa aûnh queùt ñaõ ñaêng kyù vaøo MapInfo (hình II.8).

- Update Column: caäp nhaät coät. Leänh naøy cho
pheùp caäp nhaät thoâng tin trong baûng döõ lieäu cuûa
MapInfo baèng bieåu thöùc hay baèng giaù trò töø moät
baûng döõ lieäu khaùc.

- Append Rows to Table: cho pheùp noái caùc haøng
cuûa moät baûng hay moät döõ lieäu khaùc vaøo moät
baûng ñöôïc choïn.

Xem chi tieát hai leänh treân trong Chöông XVII, muïc XVII.3.

- Geocode: maõ ñòa hoaù. Maõ ñòa hoaù laø moät leänh duøng ñeå hieån thò thoâng tin cuûa moät
baûng döõ lieäu khaùc leân baûn ñoà. Baûng khaùc naøy coù theå laø moät baûng cuûa MapInfo hay

Hình II.8. Menu Table
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moät baûng khoâng phaûi MapInfo (Excel, Access,...). Neáu laø moät baûng khoâng phaûi
MapInfo ta phaûi môû noù ra tröôùc baèng leänh Open Table ñeå ñaêng kyù noù vaøo MapInfo.
Maõ ñòa hoaù ñaùnh daáu treân baûn ñoà nhöõng ñieåm lieân keát vôùi baûng thöù hai baèng caùch
so saùnh thoâng tin giöõa lôùp baûn ñoà cuûa MapInfo vôùi döõ lieäu caàn ñöôïc maõ ñòa hoaù.
Hai baûng ñöôïc so saùnh phaûi coù chung moät coät hoaëc phaûi ñöôïc ñaùnh soá thöù töï nhö
nhau. Caùc baûn ghi (haøng) trong baûng caàn xöû lyù coù theå khoâng ñöôïc maõ ñòa hoaù heát.
Leänh maõ ñòa hoaù coù theå ñöôïc chaïy töï ñoäng (Automatic) hay chaïy theo kieåu töông
taùc (Interactive). Chi tieát veà leänh naøy ñöôïc trình baøy trong Chöông XVI.

- Create Points: laø leänh taïo caùc ñieåm treân baûn ñoà töø hai coät toïa ñoä coù trong baûng caàn
ñöôïc chaám ñieåm. Baûng caàn taïo ñieåm coù theå laø baûng cuûa MapInfo hay baûng ñònh
daïng khaùc. Neáu khoâng phaûi laø baûng cuûa MapInfo thì baûng ñoù phaûi ñöôïc môû ra trong
MapInfo baèng leänh Open Table tröôùc (xem theâm trong phaàn sau). Neáu muoán thöïc
taäp leänh naøy treân moät baûng MapInfo coù vaät theå ñoà hoaï thì ta neân sao löu baûn ñoà caàn
thöïc taäp thaønh moät baûng khaùc vì leänh naøy laøm thay ñoåi vaät theå ñoà hoaï treân moät lôùp
baûn ñoà cuûa MapInfo ñaõ coù caùc vaät theå ñoà hoaï. Chi tieát leänh naøy ñöôïc trình baøy trong
Chöông XVI.

- Combine Objects using Column: ñaây laø leänh nhaäp caùc vaät theå laïi theo döõ lieäu trong
coät. Ta phaûi chæ ñònh coät naøo ñöôïc söû duïng ñeå laøm goäp vaät theå. Nhöõng vaät theå naøo
coù chung giaù trò trong coät ñöôïc chæ ñònh seõ bò goäp laïi thaønh moät vaät theå. Neân sao löu
thaønh moät lôùp baûn ñoà khaùc tröôùc khi thöïc taäp phaàn naøy.

- Import: Nhaäp. Leänh naøy cho pheùp nhaäp caùc taäp tin coù ñònh daïng khaùc vaøo MapInfo.
Caùc ñònh daïng taäp tin coù theå nhaäp ñöôïc vaøo MapInfo laø MapInfo Interchange (*.mif),
AutoCAD DXF (*.dxf), MapInfo DOS MBI (*.mbi), MapInfo DOS MMI (*.mmi),
MapInfo DOS Image (*.img).

- Export: Xuaát. Leänh naøy xuaát döõ lieäu trong baûng MapInfo sang moät ñònh daïng khaùc.
Caùc ñònh daïng ñöôïc hoã trôï laø MapInfo Interchange (*.mif), Delimited ASCII (*.txt),
AutoCAD DXF (*.dxf) vaø dBASE DBF (*.dbf).

- Maintenance: Chænh söûa caáu truùc baûng döõ lieäu cuûa MapInfo nhö theâm tröôøng, thay
ñoåi thuoäc tính, kích thöôùc tröôøng,... Ngoaøi ra coøn coù moät soá leänh khaùc nhö xoaù baûng,
“ñoùng goùi” baûng, ñoåi teân baûng. Leänh naøy cuõng coù theâm nhöõng leänh khaùc lieân quan
ñeán caùc baûng DBMS (xem phaàn treân, menu File).

- Raster: Leänh naøy cho pheùp ñieàu chænh aûnh queùt (aûnh raster) trong MapInfo. Ta coù
theå ñieàu chænh ñoä töông phaûn cuõng nhö ñoä saùng cuûa aûnh queùt ñaõ ñöôïc môû trong
MapInfo. Noù cuõng cho pheùp ta thay ñoåi ñaêng kyù toaï ñoä aûnh queùt trong MapInfo.
Xem theâm trong Chöông II.

Chi tieát caùc leänh Maintenance vaø Raster ñöôïc trình baøy trong Chöông XVII.

II.2.1.7. Menu Options

Menu naøy goàm caùc leänh veà ñònh daïng kieåu vaät theå ñoà hoaï trong MapInfo, caùc leänh
hieån thò caùc cöûa soå vaø caùc thanh coâng cuï vaø nhöõng thieát laäp caùc tuyø choïn cuûa chöông
trình chính cuûa MapInfo (hình II.9).

- Line Style: chænh kieåu ñöôøng, töông ñöông vôùi nuùt leänh Line Style Button treân
thanh coâng cuï Drawing. Kieåu ñöôøng maëc ñònh khi khôûi ñoäng MapInfo laø ñöôøng lieàn,
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maøu ñen, neùt daøy 1 pixel.

- Region Style: chænh kieåu vuøng, töông ñöông
vôùi nuùt leänh Region Style Button treân
thanh coâng cuï Drawing. Kieåu vuøng maëc ñònh
laø ranh giôùi coù ñöôøng lieàn maøu ñen, neùt daøy
1 pixel vaø neàn traéng.

- Symbol Style: chænh kieåu ñieåm (bieåu töôïng),

töông ñöông vôùi nuùt leänh Symbol Style Button

treân thanh coâng cuï Drawing. Kieåu ñieåm

maëc ñònh laø hình ngoâi sao maøu ñen, kích

thöôùc 12 point.

- Text Style: ñieàu chænh kieåu chöõ, töông
ñöông vôùi nuùt leänh Text Style Button treân

thanh coâng cuï Drawing. Kieåu chöõ maëc ñònh laø Arial, côõ chöõ 10 point.

- Toolbar: Cho pheùp baät/taét vaø ñieàu chænh cheá ñoä hieån thò caùc thanh coâng cuï chính
cuûa MapInfo.

- Show/Hide Theme Legend Window: baät/taét cöûa soå chuù giaûi. Leänh naøy chæ coù yù nghóa
khi ta ñaõ taïo chuù giaûi töø leänh Create Legend hay chaïy leänh Create Thematic Map.
Neáu khoâng thì cöûa soå chuù giaûi cuõng môû ra nhöng khoâng coù noäi dung.

- Show/Hide Statistics Window: baät/taét cöûa soå thoáng keâ. Cöûa soå naøy thoáng keâ caùc giaù
trò toång (Sum) vaø trung bình (Average) töø caùc tröôøng kieåu soá cuûa nhöõng vaät theå ñang
ñöôïc choïn.

- Show/Hide MapBasic Window: baät/taét cöûa soå MapBasic, töông ñöông vôùi nuùt leänh
Show/Hide MapBasic Window Button neáu ta môû thanh coâng cuï Tools. Khi thöïc

hieän caùc leänh cuûa MapInfo, neáu môû cöûa soå naøy ra, ta seõ thaáy ñöôïc caùch thöùc

MapInfo thöïc hieän caùc leänh cuûa ta vì nhöõng leänh ñoù ñöôïc vieát thaønh töøng doøng leänh

treân cöûa soå naøy.

- Show/Hide Status Bar: baät/taét thanh traïng thaùi ôû döôùi cuøng soå chính cuûa MapInfo.

- Custom Colors: cho pheùp taïo theâm maøu theo yù muoán cuûa ngöôøi duøng. Neáu ñaùnh
daáu choïn vaøo Save color thì maøu ñöôïc choïn seõ ñöôïc löu laïi treân baûng choïn maøu
cuûa MapInfo.

- Preferences: cho pheùp ñieàu chænh nhöõng thieát laäp khaùc nhau theo yù muoán cuûa ngöôøi
duøng MapInfo, ví duï nhö choïn thö muïc löu caùc taäp tin baûn ñoà cuûa MapInfo, thö muïc
löu caùc taäp tin workspace, choïn maùy in, ñieàu chænh cöûa soå baûn ñoà,cöûa soå chuù
giaûi,...Chi tieát caùch söû duïng nhöõng tuyø choïn naøy ñaõ ñöôïc trình baøy trong Chöông
I.

II.2.1.8. Menu Map

Hình II.9. Menu Options
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Menu naøy bao goàm caùc leänh lieân quan ñeán cöûa soå baûn ñoà (hình II.10).

- Layer Control: Kieåm soaùt lôùp, töông ñöông vôùi nuùt leänh Layer Control Button
treân thanh coâng cuï Main. Leänh naøy cho pheùp ta ñieàu chænh vieäc hieån thò hay taét caùc

lôùp ñang môû, baät moät lôùp naøo ñoù sang cheá ñoä chænh söûa, theâm moät lôùp ñaõ môû vaøo

cöûa soå baûn ñoà, daùn nhaõn cho caùc vaät theå treân baûn ñoà,...Xem chi tieát trong Chöông
X.

- Create 3D Map: Taïo baûn ñoà 3 chieàu töø moät taäp tin grid (löôùi). Taäp tin grid naøy ñöôïc
taïo ra baèng leänh Create Thematic Map. Xem chi tieát trong Chöông XIII, muïc
XIII.2.6.

- Create Thematic Map: Taïo baûn ñoà chuû ñeà.
Leänh naøy noùi moät caùch noâm na laø “toâ maøu”
cho baûn ñoà theo caùc giaù trò coù trong tröôøng döõ
lieäu cuûa baûn ñoà hay caùc soá lieäu ngoaøi lieân keát
vôùi baûn ñoà, ñoàng thôøi laøm chuù giaûi cho vieäc toâ
maøu ñoù. Xem chi tieát trong Chöông XIII.

- Modify Thematic Map: Thay ñoåi, ñieàu chænh
baûn ñoà chuû ñeà ñöôïc taïo thaønh trong leänh treân.

- Create Legend: Laøm chuù giaûi cho baûn ñoà. Xem
chi tieát trong Chöông XIII, muïc XIII.1.2.2.

- Change view: Thay ñoåi tyû leä cuûa baûn ñoà baèng
caùch naïp thoâng soá. Chi tieát ñöôïc trình baøy
trong Chöông XI, muïc XI.3.1.

- Clone View: sao ra moät cöûa soå baûn ñoà môùi töø
moät cöûa soå baûn ñoà ñang ñöôïc kích hoaït.

- Previous View: quay trôû laïi cheá ñoä hieån thò
tröôùc ñoù cuûa cöûa soå baûn ñoà ñang ñöôïc kích
hoaït.

- View Entire Layer: thay ñoåi tyû leä cuûa baûn ñoà
sao cho coù theå nhìn thaáy heát caùc vaät theå trong
moät hay taát caû caùc lôùp baûn ñoà ñang môû trong cöûa soå ñoù.

- Clear Custom Labels: xoaù caùc nhaõn ñöôïc taïo ra moät caùch thuû coâng.

- Save Cosmetic Objects: löu laïi caùc vaät theå ñöôïc veõ treân lôùp Cosmetic thaønh moät lôùp
môùi hay löu vaøo moät lôùp baûn ñoà ñang môû. Xem theâm veà lôùp Cosmetic trong Chöông
X.

- Clear Cosmetic Layer: xoaù boû caùc vaät theå ñöôïc taïo ra treân lôùp Cosmetic.

- Set Clip Region: Thieát laäp vuøng caét, töông ñöông vôùi nuùt leänh Set Clip Region Button

treân thanh coâng cuï Main. Leänh naøy cho pheùp ta chæ hieån thò baûn ñoà trong giôùi

haïn cuûa vuøng ñöôïc choïn. Sau khi ñaõ choïn vuøng caét ta coù theå baät cheá ñoä naøy leân

hay khoâng ñoàng thôøi cuõng coù theå thay ñoåi vuøng caét neáu muoán. Xem chi tieát trong

Hình II.10. Menu Map
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Chöông X, muïc X.1.2.

- Clip Region On/Off: baät/taét vuøng caét, laø On khi ñaõ coù vuøng caét vaø chöa baät leân, Off

khi vuøng caét ñaõ ñöôïc baät leân, töông ñöông vôùi nuùt leänh Clip Region On/Off Button

treân thanh coâng cuï Main. Xem chi tieát trong Chöông X, muïc X.1.2.

- Digitizer Setup: ñaây laø phaàn lieân quan ñeán vieäc ñieàu chænh thieát bò soá hoaù. Thieát bò
soá hoaù (Digitizer) hay baøn soá hoaù (Digitizing Table) laø moät thieát bò ñöôïc noái vaøo maùy
tính. Noù cho pheùp ta ñöa baûn ñoà giaáy vaøo thieát bò naøy vaø can laïi baûn ñoà giaáy ñoù.
Quaù trình can laïi baûn ñoà treân baøn soá hoaù cuõng ñöôïc sao laïi trong MapInfo. Coâng
vieäc naøy goïi laø soá hoaù baûn ñoà. Tuy nhieân baøn soá hoaù laø moät thieát bò ñaét tieàn maø chæ
coù nhöõng cô quan chuyeân duïng môùi duøng. Cuoán saùch naøy ñeà caäp ñeán moät phöông
phaùp phoå thoâng hôn laø soá hoaù baûn ñoà tröïc tieáp treân MapInfo baèng aûnh queùt. Vôùi
phöông phaùp naøy moïi ngöôøi ñeàu coù theå söû duïng ñöôïc MapInfo ñeå soá hoaù baûn ñoà.

- Options: ñieàu chænh caùc tuyø choïn trong cöûa soå baûn ñoà cuûa MapInfo.Ta coù theå thay
ñoåi ñôn vò toaï ñoä, khoaûng caùch, dieän tích,... cuõng nhö cheá ñoä cöûa soå baûn ñoà phoùng
to, thu nhoû,..., caùch thöùc hieån thò thoâng tin treân cöûa soå baûn ñoà,...

II.2.1.9. Menu Window
Menu naøy cho pheùp ta môû hay ñieàu chænh cheá ñoä hieån thò cuûa caùc cöûa soå ñang

ñöôïc môû.

- New Browser Window: môû moät cöûa soå döõ lieäu môùi, töông ñöông vôùi nuùt leänh New
Browser Button treân thanh coâng cuï Standard. Cöûa soå môùi naøy coù theå laø toaøn

boä baûng döõ lieäu cuûa moät lôùp baûn ñoà hoaëc moät phaàn döõ lieäu cuûa moät baûng tuyø thuoäc

vaøo pheùp choïn ñöôïc thöïc hieän tröôùc ñoù.

- New Map Windows: môû moät cöûa soå baûn ñoà môùi, töông ñöông vôùi nuùt leänh New
Mapper Button treân thanh coâng cuï Standard. Cöûa soå baûn ñoà môùi naøy coù theå

laø toaøn boä caùc vaät theå ñoà hoaï cuûa moät lôùp naøo ñoù hoaëc moät phaàn caùc vaät theå ñoà

hoaï cuûa moät baûng, tuyø thuoäc vaøo

leänh choïn tröôùc ñoù.

- New Graph Window: thöïc hieän

leänh veõ bieåu ñoà/ñoà thò, töông

ñöông nuùt leänh New Grapher
Button treân thanh coâng cuï

Standard. Chi tieát leänh naøy ñöôïc

trình baøy trong Chöông XV.

- New Redistrict Window: thöïc hieän
leänh phaân chia nhoùm (Redistrict), Hình I.11. Menu Window
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töông ñöông vôùi nuùt leänh New Redistricter Button treân thanh coâng cuï

Standard. Chi tieát ñöôïc trình baøy trong Chöông XIV.

- Redraw Window: veõ laïi cöûa soå ñang ñöôïc kích hoaït. Leänh naøy töông töï nhö leänh laøm
töôi maøn hình (refresh) cuûa heä ñieàu haønh nhöng chæ taùc ñoäng leân cöûa soå baûn ñoà maø
thoâi.

- Tile Windows: Saép xeáp taát caû caùc cöûa soå ñang môû sao cho chuùng ñeàu ñöôïc hieån thò
treân maøn hình.

- Cascade Windows: Saép xeáp taát caû caùc cöûa soå ñang môû sao cho tieâu ñeà cuûa chuùng
ñeàu coù theå nhìn thaáy ñöôïc.

- Arrange Icons: Saép xeáp laïi caùc nuùt leänh.

Phaàn döôùi cuøng cuûa menu Window lieät keâ danh saùch caùc cöûa soå ñang ñöôïc môû
trong MapInfo.

II.2.1.10. Menu Help

Menu naøy laø phaàn trôï giuùp cuûa MapInfo (hình II.12).

- MapInfo Help Topics: khôûi ñoäng phaàn giuùp ñôõ cuûa MapInfo.

- MapInfo on the Web: khôûi ñoäng lieân keát vaøo trang web cuûa MapInfo. Trang web naøy
coù ñòa chæ laø httt://www.mapinfo.com.

- MapIndo Data Products on the Web: khôûi ñoäng lieân keát internet vaøo trang web coù
caùc saûn phaåm cuûa MapInfo.

- MapInfo Data and Solutions for Europe: töông töï nhö treân nhöng lieân keát vaøo trang
web coù caùc thoâng tin veà chaâu AÂu.

- About MapInfo: Giôùi thieäu phieân baûn cuõng nhö soá ñaêng kyù baûn quyeàn vaø caùc thoâng
tin lieân quan ñeán phaàn meàm MapInfo ñang ñöôïc söû duïng.

II.2.2. Thanh coâng cuï Standard

Thanh coâng cuï naøy goàm coù caùc nuùt leänh
sau (tính töø traùi sang phaûi, hình II.13):
1 -   New Table Button: taïo baûng môùi, töông

ñöông leänh File > New Table.
2 -  Open Table Button: môû moät baûng,

töông ñöông leänh File > Open Table.
3 - Save Table Button: löu moät baûng, töông

ñöông leänh File > Save Table.
4 -   Print Window Button: in moät cöûa soå ñang ñöôïc kích hoaït.
5 -   Cut Button: Caét moät hay nhieàu vaät theå hay döõ lieäu ñang ñöôïc choïn. Vaät theå bò

caét ñöôïc ñöa vaøo boä nhôù taïm; töông töï leänh Edit > Cut.
6 -   Copy Button: löu moät hay nhieàu vaät theå (hay döõ lieäu) ñang ñöôïc choïn vaøo boä nhôù

taïm; töông ñöông leänh Edit > Copy.

Hình II.12. Menu Help
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7 -   Paste Button: daùn moät hay nhieàu vaät theå hay döõ lieäu bò caét baèng leänh Cut hay
ñöôïc löu baèng leänh Copy vaøo cöûa soå ñang ñöôïc kích hoaït; töông ñöông leänh Edit
> Paste.

8 -   Undo Button: huyû boû moät leänh vöøa thöïc hieän; töông ñöông leänh Edit > Undo.
9 -   New Browser Button: môû moät cöûa soå döõ lieäu môùi; töông ñöông leänh Window >

New Browser Window.
10 - New Mapper Button: môû moät cöûa soå baûn ñoà môùi; töông ñöông leänh Window >

New Mapper Window.
11 - New Grapher Button: thöïc hieän leänh veõ bieåu ñoà/ñoà thò; töông ñöông leänh Window

> New Graph Window.
12 - New Layout Button: môû moät cöûa soå trình baøy môùi; töông ñöông leänh Window >

New Layout Window.
13 - New Redistricter Button: thöïc hieän leänh phaân chia nhoùm; töông ñöông leänh

Window > New Redistrict Window.
14 - Help Button: Giuùp ñôõ. Khi nhaép chuoät vaøo nuùt leänh naøy, con troû chuoät bieán thaønh

hình con troû vaø daáu chaám hoûi. Nhaép chuoät leân noäi dung naøo trong MapInfo seõ
hieån thò noäi dung giuùp ñôõ lieân quan ñeán phaàn ñoù.

II.2.3. Thanh coâng cuï Main

Thanh coâng cuï Main (hình II.14) coù caùc nuùt leänh sau:

1 - Select Button: Nuùt leänh choïn duøng ñeå choïn vaät theå treân cöûa soå baûn ñoà, baûn ghi
treân cöûa soå Browser hay caùc noäi dung treân moät soá cöûa soå khaùc. Nuùt naøy ñöôïc söû
duïng phoái hôïp vôùi phím <Shift> ñeå choïn nhieàu vaät theå hay nhieàu baûn ghi moät luùc.
Neáu nhieàu vaät theå ñang ñöôïc choïn, giöõ phím <Shift> vaø nhaép chuoät leân vaät
theå/baûn ghi naøo seõ khöû choïn noù.

2 - Marquee Select Button: choïn theo hình chöõ nhaät, laø coâng cuï choïn baèng caùch reâ
chuoät treân vuøng muoán choïn. Khi reâ chuoät vuøng ñöôïc veõ laø hình chöõ nhaät vaø khi
thaû chuoät nhöõng vaät theå naèm trong hình chöõ nhaät ñöôïc choïn.

3 - Radius Select Button: choïn theo hình troøn, laø coâng cuï choïn baèng caùch reâ chuoät,
khi reâ chuoät moät hình troøn ñöôïc taïo thaønh vaø khi thaû chuoät ra taát caû nhöõng vaät theå
naèm trong voøng troøn ñoù seõ ñöôïc choïn.

4 - Polygon Select Button: choïn baèng caùch veõ moät vuøng, laø coâng cuï choïn baèng caùch
veõ moät vuøng, nhöõng vaät theå naèm trong vuøng ñoù seõ ñöôïc choïn.

5 - Boundary Select Button: laø coâng cuï choïn baèng caùch nhaép chuoät leân moät vuøng ñaõ
coù treân moät lôùp baûn ñoà ñaõ coù, nhöõng vaät theå naèm trong vuøng ñoù nhöng thuoäc moät
lôùp khaùc seõ ñöôïc choïn.

6 - Unselect All Button:  khöû choïn taát caû nhöõng vaät theå hay baûn ghi ñang ñöôïc choïn

1    2    3     4     5    6    7     8     9  10  11  12  13   14
Hình II.13. Thanh coâng cuï Standard
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7 - Graph Select Button: choïn moät giaù trò treân bieåu ñoà. Ñoái
vôùi nhöõng bieåu ñoà ñöôïc taïo ra khoâng döïa vaøo nhöõng
giaù trò trong baûng döõ lieäu thì nuùt naøy khoâng hoaït ñoäng.

8 - Zoom-in Button: phoùng to baûn ñoà baèng caùch nhaép
chuoät hay reâ chuoät choïn moät vuøng. Moãi laàn nhaép chuoät
baûn ñoà seõ phoùng to ra gaáp ñoâi.

9 - Zoom-out Button: töông töï nuùt Zoom-in nhöng laø nuùt thu
nhoû. Moãi laàn nhaép chuoät baûn ñoà thu nhoû laïi moät nöûa.

10- Change View Button: Thay ñoåi tyû leä vaø vò trí baûn ñoà
baèng caùch naïp giaù trò.

11- Grabber Button: nuùt coâng cuï naøy duøng ñeå di chuyeån
baûn ñoà. Muoán di chuyeån baûn ñoà, ta nhaép chuoät choïn
nuùt naøy, di chuyeån chuoät laïi cöûa soå baûn ñoà, reâ chuoät thì
baûn ñoà seõ di chuyeån.

12- Info Tool Button: xem thoâng tin cuûa moät vaät theå treân
baûn ñoà baèng caùch nhaép chuoät choïn vaät theå ñoù treân cöûa
soå baûn ñoà.

13- Hot Link Button: môû moät taäp tin hay moät ñòa chæ treân
maïng khaùc ñöôïc lieân keát vôùi vaät theå treân baûn ñoà hay
baûn ghi trong cöûa soå Browser thoâng qua vieäc thieát laäp
ñöôøng daãn trong moät tröôøng cuûa baûng MapInfo. Xem
chi tieát trong Chöông X, muïc X.7.2.

14- Label Button: nuùt naøy duøng ñeå daùn nhaõn thuû coâng caùc vaät theå treân cöûa soå baûn ñoà
baèng döõ lieäu töø baûng. Xem chi tieát trong Chöông X, muïc X.5.4.

15- Drag Map Window Button: Cho pheùp keùo moät cöûa soå baûn ñoà hieän haønh sang moät
phaàn meàm khaùc (chöùc naêng OLE). Muoán thöïc hieän ñieàu naøy ta phaûi môû hai cöûa
soå ñoàng thôøi, cöûa soå MapInfo vaø cöûa soå phaàn meàm kia, Word chaúng haïn, roài choïn
nuùt naøy, ñeå con troû chuoät treân cöûa soå baûn ñoà, reâ chuoät sang cöûa soå kia. Baûn ñoà
seõ ñöôïc cheøn vaøo vò trí cuûa con troû chuoät treân phaàn meàm kia.

16- Layer Control Button: töông töï leänh Map > Layer Control, cho pheùp vaøo hoäp thoaïi
kieåm soaùt lôùp. Chi tieát hoäp thoaïi kieåm soaùt lôùp ñöôïc trình baøy trong Chöông X.

17- Ruler Button: ño khoaûng caùch treân baûn ñoà baèng caùch di chuyeån chuoät vaø nhaép
chuoät. Khoaûng caùch ñöôïc tính laø ñoä daøi caùc ñoaïn thaúng noái töø vò trí nhaép chuoät
naøy sang vò trí nhaép chuoät khaùc. Khi choïn nuùt leänh naøy cöûa soå Ruler môû ra vaø
thoâng tin veà khoaûng caùch hieån thò trong ñoù, thoâng tin naøy thay ñoåi khi ta di chuyeån
vaø nhaép chuoät.

18- Show/Hide Legend Button: baät/taét cöûa soå chuù giaûi. Xem theâm trong Chöông XIII,
muïc XIII.1.2.2.

19- Show/Hide Statistics Button: baät/taét cöûa soå thoáng keâ, cöûa soå naøy hieån thò giaù trò
toång (Sum) vaø trung bình (Average) trong caùc tröôøng kieåu soá cuûa caùc vaät theå ñang
ñöôïc choïn.

20- Set Target District Button: thieát laäp nhoùm chöùa vaät theå ñöôïc choïn treân cöûa soå baûn
ñoà thaønh moät nhoùm muïc tieâu trong cöûa soå Districts Browser.
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21- Assign Selected Objects Button: gaùn nhöõng vaät theå ñöôïc choïn vaøo nhoùm muïc tieâu.

Chi tieát hai nuùt leänh 20 vaø 21 ñöôïc trình baøy trong Chöông XIV.

22- Clip Region On/Off Button: baät/taét cheá ñoä caét vuøng.

23- Set Clip Region Button: thieát laäp vuøng caét.

Chi tieát hai nuùt leänh 22 vaø 23 ñöôïc trình baøy trong Chöông X, muïc X.1.2.

II.2.4. Thanh coâng cuï Drawing

Ñeå söû duïng ñöôïc caùc nuùt leänh naøy, phaûi coù moät lôùp baûn ñoà ñang ôû cheá ñoä chænh
söûa. Caùc nuùt leänh naøy chæ coù taùc duïng treân cöûa soå baûn ñoà. Thanh coâng cuï naøy goàm
16 nuùt leänh (hình II.15) vôùi yù nghóa nhö sau:

1-  Symbol Button (Nuùt veõ bieåu töôïng): veõ moät ñieåm treân baûn ñoà. Caùch veõ: choïn nuùt
naøy roài nhaép chuoät leân vò trí muoán chaám bieåu töôïng. Bieåu töôïng ñöôïc taïo thaønh laø
bieåu töôïng maëc ñònh hình ngoâi sao maøu ñen, côõ 12, tröø khi tröôùc ñoù ta ñaõ chænh
bieåu töôïng sang kieåu khaùc.

2-  Line Button (Nuùt leänh veõ ñöôøng thaúng): laø nuùt leänh veõ
ñöôøng thaúng. Caùch laøm: choïn nuùt coâng cuï naøy, nhaép
chuoät traùi taïi vò trí baét ñaàu vaø reâ chuoät ñeán ñieåm keát
thuùc roài thaû phím chuoät traùi ra.

3-  Polyline Button (Nuùt leänh veõ ñöôøng gaáp khuùc): veõ moät
ñöôøng gaáp khuùc treân cöûa soå baûn ñoà. Ñaây laø nuùt leänh
ñöôïc söû duïng nhieàu nhaát trong veõ ñöôøng. Caùch veõ:
Choïn nuùt leänh naøy, di chuyeån chuoät laïi cöûa soå baûn
ñoà, con troû chuoät bieán thaønh hình daáu coäng, nhaép
chuoät taïi vò trí muoán baét ñaàu veõ, di chuyeån chuoät roài
laïi nhaép chuoät ñeå taïo ra moät ñoaïn, thöïc hieän töông
töï cho ñeán khi veõ heát ñöôøng caàn veõ. Nhaép chuoät ñuùp
taïi vò trí keát thuùc ñeå chaám döùt ñöôøng veõ hay nhaép
chuoät moät laàn taïi vò trí keát thuùc roài nhaán phím <Esc>.

4-  Arc Button (Nuùt leänh veõ moät cung): Nuùt leänh naøy cho
pheùp ta veõ moät cung. Caùch veõ töông töï nhö caùch veõ
moät ñöôøng thaúng

5-  Polygon Button (Nuùt leänh veõ ña giaùc): Nuùt leänh naøy veõ moät hình ña giaùc (töùc moät
vuøng). Caùch veõ töông töï nhö caùch veõ moät ñöôøng nhöng khi keát thuùc ñöôøng thì noát
cuûa ñoaïn cuoái cuøng seõ noái vaøo noát ñaàu tieân cuûa ñoaïn ñaàu tieân ñeå kheùp kín ñöôøng
veõ vaø taïo ra moät vuøng. Neáu ta nhaép chuoät ñuùp thì noát taïo thaønh cuoái cuøng seõ ñöôïc
noái vôùi noát ñaàu tieân vaø kheùp kín ñöôøng veõ ñeå taïo thaønh vuøng.

6-  Ellipse Button (Nuùt leänh veõ hình ellipse): veõ moät hình ellipse. Khi söû duïng nuùt leänh
naøy neáu giöõ phím <Shift> thì ta seõ veõ ñöôïc moät hình troøn. Caùch veõ töông töï caùch
veõ ñöôøng thaúng.

7-  Rectangle Button (Nuùt leänh veõ hình chöõ nhaät): veõ hình chöõ nhaät. Khi giöõ phím
<Shift> keát quaû seõ taïo ra hình vuoâng. Caùch veõ töông töï caùch veõ ñöôøng thaúng.

8-  Rounded Rectangle Button (Nuùt leänh veõ hình chöõ nhaät bo troøn goùc): veõ hình chöõ
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nhaät bo troøn, giöõ phím <Shift> khi veõ seõ taïo ra hình vuoâng goùc bo troøn. Caùch veõ
töông töï caùch veõ ñöôøng thaúng. Khi ñoåi moät hình chöõ nhaät bo troøn goùc thaønh ñöôøng
baèng leänh Convert to region, goùc bo troøn seõ bò maát.

9-  Text Button (Nuùt leänh goõ chöõ): cho pheùp goõ chöõ tröïc tieáp leân cöûa soå baûn ñoà. Nuùt
leänh naøy taïo ra moät vaät theå ñaëc bieät treân baûn ñoà trong MapInfo, ñoù laø vaät theå kieåu
kyù töï. Caùch goõ: nhaép chuoät choïn coâng cuï naøy roài di chuyeån chuoät vaøo cöûa soå baûn
ñoà, nhaép chuoät taïi vò trí muoán goõ chöõ, baét ñaàu thöïc hieän goõ noäi dung caàn thieát, sau
khi goõ xong, di chuyeån chuoät veà thanh coâng cuï Main nhaép chuoät choïn coâng cuï
choïn, leänh goõ chöõ seõ keát thuùc. Neáu nhaép chuoät treân cöûa soå baûn ñoà thì moät vaät theå
kyù töï thöù hai seõ baét ñaàu taïi vò trí nhaép chuoät ñoù.

10- Frame Button (Nuùt leänh taïo khung): taïo moät khung ñeå chöùa thoâng tin trong cöûa soå
trình baøy. Khi söû duïng nuùt leänh naøy ñeå veõ moät khung, MapInfo seõ hieån thò hoäp thoaïi
hoûi ta muoán cheøn noäi dung naøo vaøo khung ñoù. Noäi dung coù theå ñöôïc cheøn vaøo laø
moät trong nhöõng cöûa soå ñang ñöôïc môû trong MapInfo. Cöûa soå ñöôïc cheøn vaøo
khung coù theå laø moät baûn ñoà, moät bieåu ñoà, moät cöûa soå döõ lieäu, chuù giaûi baûn ñoà, cöûa
soå Info (thoâng tin), cöûa soå thoáng keâ (statistics), cöûa soå thoâng ñieäp (message) hoaëc
noù coù theå laø moät khung roãng (khoâng coù noäi dung).

11- Reshape Button (Nuùt leänh chænh söûa hình daïng): chænh söûa hình daïng cuûa vaät theå
sau khi ñaõ veõ xong. Nuùt leänh naøy chæ söû duïng ñöôïc khi naøo coù moät lôùp baûn ñoà
ñang ôû cheá ñoä chænh söûa vaø moät vaät theå trong lôùp ñoù ñöôïc choïn.

12- Add Node Button (Nuùt leänh theâm noát): theâm moät noát vaøo moät vaät theå kieåu ñöôøng
hay vuøng. Nuùt leänh naøy chæ söû duïng ñöôïc khi nuùt leänh chænh söûa hình daïng ñöôïc
kích hoaït.

13- Symbol Style Button (Nuùt leänh chænh kieåu bieåu töôïng): cho pheùp ta chænh söûa kieåu
bieåu töôïng. Nuùt leänh naøy laø leänh taét cuûa leänh Options > Symbol Style.

14- Line Style Button (Nuùt leänh chænh kieåu ñöôøng): cho pheùp chænh söûa kieåu ñöôøng.
Ñaây laø nuùt leänh taét cuûa leänh Options > Line Style.

15- Region Style Button (Nuùt leänh chænh kieåu vuøng): cho pheùp chænh söûa kieåu vuøng.
Ñaây laø leänh taét cuûa leänh Options > Region Style.

16- Text Style Button (Nuùt leänh chænh kieåu chöõ): Nuùt leänh naøy cho pheùp ta chænh kieåu
chöõ. Nuùt leänh naøy coù taùc duïng treân caû cöûa soå baûn ñoà laãn cöûa soå Browser, tuyø theo
cöûa soå naøo ñang ñöôïc kích hoaït luùc ñoù. Ñaây laø leänh taét cuûa leänh Options > Text
Style.

II.2.5. Thanh coâng cuï DBMS 
(töø MapInfo phieân baûn 6.0 trôû veà sau) hay ODBC

Thanh coâng cuï naøy (hình II.16) goàm caùc leänh lieân quan ñeán caùc cô sôû döõ lieäu ngoaøi
MapInfo. Noù goàm 6 nuùt leänh (töø traùi qua phaûi):

1- Open DBMS Table Button: vaøo hoäp thoaïi ñaàu tieân cuûa leänh môû cô sôû döõ lieäu ngoaøi
MapInfo. Nuùt leänh naøy laø leänh taét cuûa leänh File > Open DBMS Table.

2- Refresh DBMS Table Button: caäp nhaät laïi nhöõng gì môùi thay ñoåi trong moät baûng
ñöôïc lieân keát vaøo MapInfo.

3- Unkink DBMS Table Button: ngaét lieân keát vôùi moät cô sôû döõ lieäu ngoaøi MapInfo. Leänh
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naøy khoâng ñöôïc kích hoaït neáu baûng lieân keát ñang ôû
cheá ñoä chænh söûa. Tröôùc heát phaûi caäp nhaät nhöõng
thay ñoåi baèng leänh Save Table. Leänh naøy seõ taïo ra
moät baûng MapInfo bình thöôøng.

4- Make DBMS Table Mappable Button: truy xuaát döõ
lieäu toaï ñoä treân caùc coät coù chöùa toïa ñoä cuûa cô sôû döõ
lieäu ngoaøi MapInfo vaø sau ñoù hieån thò caùc baûn ghi
cuûa sô sôû döõ lieäu ngoaøi ñoù leân cöûa soå baûn ñoà trong MapInfo.

5- Change Symbol for a Mappable DBMS Table Button: thay ñoåi bieåu töôïng cuûa moät
baûng DBMS ñaõ ñöôïc hieån thò treân cöûa soå baûn ñoà.

6- Disconnect DBMS Button: Ngaét lieân keát vôùi cô sôû döõ lieäu DBMS naøo ñang ñöôïc môû
trong MapInfo. Leänh naøy chæ coù taùc duïng khi naøo taát caû caùc baûng trong cô sôû döõ
lieäu ñoù ñeàu ñoùng. Neáu caùc baûng trong cô sôû döõ lieäu ngoaøi ñang ñöôïc môû thì thoâng
baùo loãi seõ hieän ra. Ñaây laø leänh taét cuûa leänh File > Close DBMS Connection.

Hình II.16.Thanh coâng
cuï DBMS
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